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Introduction

Welcome to TRUMP CASTLE II, the all new Ultimate
Casino Gambling Sumulation inspired by the fabulous Trump
Castle Casino Resort by the Bay in Atlantic City. Enjoy all
the glamour, games and thrills of trying to capture a king's
ransom - just as if you were actually inside Trump Castle.

Experience the super-charged atmosphere as you move about
the spectacular casino. Catch conversations around the gam-
ing tables, Digitized photos, animation, plus realistic graphics
and sound bring the king-size excitement of Trump Castle
right 0 your computer screen.

TRUMP CASTLE II offers six popular gambling games -
Baccarat, Blackjack, Craps, Rouletie, Video Poker, and Slots
- each with multi-player capabilities. Enjoy simultaneous
casino action for up to four players, or practice strategies
playing multiple hands. Game play follows the rules and
regulations of the New Jersey Casino Commission (except
Video Poker) .

From the exciting animation and sound to the realistic

play, multi-player capabilities and more - TRUMP CASTLE
IT sets a new standard for casino computer programs. So gel
ready for unlimited excilement and fun. Whatever your game,
it's a safe bet you'll love the challenge and thrills of TRUMP
CASTLE IIL Good Luck!

“These rules and regulations may change from time to time. Always confirm
all rules in effect prior to actual gambling.
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Getting started

Requirements

In order to run Trump Castle I you will need the following
equipment;
* A Macintosh computer
= 1 MB available RAM for the Color Version, 512K
available RAM for the Black & White Version.

» A hard drive with at least 2 megabyies available.

NOTE: Please be sure you have the computer properly
hooked up and are familiar with its operation. If there are
questions about the computer, please refer to your owner's
manual.

Installation

Before you can run Trump Castle II, you must install the
software. To install Trump Castle 11 on your hard drive, insert
Trump Castle 11 Disk into your disk drive (insert the color
version disk if you have a color system, or insert the black &
white disk otherwise).

To install Trump Castle II into its own folder, create a New
Folder using the File menu and name it TRUMP CASTLE
IL

Double-click on the Trump Castle II disk icon. Now, double-
click on the "Click on Me" icon to extract the program onto
your hard drive. You will then be asked to select a destination
folder for the program. Select the TRUMP CASTLE Il folder
by double-clicking on its name in the file selector.

Once you have selected the folder, click on Extract to begin
the installation. It will take a few minutes to extract all of the
files onto your hard drive.
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Running the Program

To run the program, open the TRUMP CASTLE 1 folder and
double-click on the Trump Castle II icon.

Starting the Program

Bankroll

Once loaded, the program will display an opening sequence
(Color version only). At any point during the opening, press
the mouse button to start the game.

Player’s names

Before you start playing the games, you are asked to enter the
names of one to four players. Select the number of players.
Enter the name for Player #1. For each player that is going to
play click in the player’s name box and enter his/her name (or
press the TAB key to move between the name boxes). After
you have entered all of the players’ names, press the RE-
TURN key.

Each time you start the game, you will have $1,000. You can
use this money anywhere in the casino. Use all of your gaming
ability to build upon this bankroll.
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Playing the Game

Color ver_s_iun

Trump Castle 11 uses a point and click interface. Each screen
in the game has one or more areas that you can click on to
select an option or perform some type of action. Also, many
of the people in the program have things to say. When a screen
with a digitized picture is displayed, pressing the mouse
button will show you a box around each and every avalable
click area on the screen.

To select an area, point at the area and press the button.

The first thing you will see after the opening sequence is the
lobby. From the lobby you can access any of the following
Options:

Exit the casino

Visit the cashier

Play roulette

Play craps

Play blackjack

Play poker

Play baccarat
Play slot machines

Exit the casino

Choose this option to leave the casino or click on the escalator

to go 0 the Bus Stop. You will be downstairs preparing to get
on the Trump Castle bus. Choose the bus to leave the game.

Visit the cashier

If you run out of money, you can go to the change booth and
receive 51,000,
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Black & White Version

After the program loads, the main Trump Castle II screen will
be displayed. On this screen are 6 icons representing the six
games. To select a game, point at its corresponding icon and
chck.

Menus

File

There are three menus that you will use from the Trump Castle
II main screen: File, Play and Settungs. Their functions are

described below

Load Old Game

This option allows you to load a game that was previously
saved. Select the game from the file selector and choose
OPEN.

Save Current game

From the file selector, choose a location for the save file
(Trump Castle II folder) and enter a valid filename up to 8
characters in length and press RETURN. The program will
save the current game, including players’ names and bankroll
amounts, to that file.

Quit Trump Castle
This option exits the game and retums you to the desktop.

The Play menu provides an optional way to play any of the
six games. Simply select the desired game from the menu.
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Settings

Sound

A check mark will appear next to the Sound option if sound
is turned on. To tumn sound off, select this option. To turn
sound back on, select this option agan.

Display Resulis

If you want the program to display the results of each tum
{e.g. spin of the slot machine), select this option. A check mark
will appear next to this option when it is selected.

Get More Money

If you are out of money, you can select this option to get
another $1000.

Options Menu

When you are playing any of the six games, you will have an
optons menu on the menu bar. The choices available on the
options menu are described in the individual sections for each
game in this manual.

THE GAMES

By selecting a game you will go to that area of the casino. You
can see what the other players have to say and then play the

game.

Black & White users: When you select a game, you will
go directly to that game. You will not have the opportunity
to have the characters in the games talk.
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Roulette

After selecting roulette from the lobby, you will find yourself
standing around the roulette table with several people (color

- version only). Most of the people here have something 1o say.

‘When you are ready to play, click in the middle of the table.
Trump Castle IT offers two types of roulette, 0 and Double 0.
When asked, choose the one that you want to play. You will
then be asked to select the table minimum ($1, $5, $25, $100).

Placing bets

The names of all the players along with the amount of their
bankroll are displayed on the lower righthand side of the
SCIedn.

Each player can take turns placing bets between each spin. To
swilch the current player, click on the desired Player button
on the lower lefthand portion of the screen.

To place a bet, click on the desired chip amount and hold the
mouse button. Now place the pointer over the table at the
point at which you would like to place your bet and release
the button. The chip will stay at the selected spot.

When all bets are placed, click on the Spin button,
Clearing bets
To clear all the bets off the table, click on the Clear button.

Options Menu

Clear Bets

To clear all bets off of the table. Performs same job as Clear
button.

Spin Wheel
Performs same function as Spin button.
Payolls

Shows a table of how much each type of bet pays. Click the
maouse button to make the payoff table disappear.
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Rules

Displays the basic rules for playing roulette. Click the mouse
button when you are done reading the rules.

Quit Roulette
Perfonns the same function as the Quit button.

e ————— e

Afler selecting craps, you will see the craps table with several
other guests standing around (color version only). You can see
what they have to say and then click in the middle of the table
to play. You will be asked to select a table minimum ($1, $5,
325, $100).

Placing bets

The names of all the players along with the amount of their
bankroll are displayed on the lower righthand side of the
SCrecn.

Each player can take mrns placing bels between each roll. To
switch the current player, click on the desired Player button
on the lower lefthand portion of the screen,

To place a bet, click on the desired chip amount and hold the
mouse button. Now place the pointer over the table at the
point at which you would like to place your bet and release
the button. The chip will stay at the selected spot.

When all bets are placed, click on the Rell button.
Clearing bets
To clear all the bets off the table, click on the Clear button.

To clear an individual bet, place the pointer over the bet and
hold down the command key and click the mouse button.

Options Menu

Remove a bet
Tells you how to remove an individual bet from the table.
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Blackjack

Roll Dice
Performs same function as Roll button.
Payofls

Shows a table of how much each type of bet pays. Click the
mouse button to make the payoff table disappear.

Rules

Displays the basic rules for playing craps. Click the mouse
button when you are done reading the rules.

Quit Craps
Performs the same function as the Quit button.

After selecting Blackjack, you will be seated at a blackjack
table in the casino (color version only). There will be many
other people around the table. You can see whal they have to
say and then click in the middle of the table to play. You will
then be asked to select a table minimum ($1, $5, 525, $100).

At Trump Castle, Blackjack is played with six decks of cards.

The names of all the players along with the amount of their
bankroll are displayed on the lower righthand side of the
screen.

The four playing positions are represented by white boxes on
the screen. Any player can play in any position, Or il more

Placing bets

Select a player by clicking on one of the four player buttons
on the lower lefthand side of the screen.

To place a bet for the selected player, click on the desired chip
amount and hold the mouse button. Now place the pointer
over the table at the bet circle below the white box for the
desired position. Release the button and the chip will stay at
the selected spot.
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When all bets are placed, click on the Deal button.
Clearing bets

To clear all the bets off the table, select the Clear Bets option
from the Options menu.

Game play

The dealer will deal cards to each position that has made a
wager. After all of the hands have been deall, positon one will
be lhighlighted. The player who has wagered in this position
will be given iwo options at the bottom of the screen (Hit and
Stand). The player will make his/her choices by clicking on
the appropriate buttons.

When that player stands or busts, the box will move to the
next position and that player can make his/her choices.

If the dealer’s face card is an Ace, each player will be offered
insurance. Follow the instructions on screen for placing in-
surance bels.

Alter all of the players have made their choices, the dealer
will either stand or take a hit. After the dealer stands or busts,
all winning bets will be paid.

Options Menu

Clear Bets

Remove all bets from the table.

Hit

Gives current player another card.

Stand

Current players stands on current cards.

Double Down

Curmrent player can choose to double hissher current bet and
receive only one additional card. You are prompted to enter
the amount of additional bet to make.
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Split Pair

If the current player has been dealt a pair, he/she can choose
to split. The amount of the bet is doubled and cards are dealt
io each card from the pair.

Deal
Performs the same function as the Deal button.

Payoffs

Shows a table of how much each type of bet pays. Click the
mouse button to make the payofl lable disappear.

Rules

Displays the basic rules for playing blackjack. Click the
mouse button when you are done reading the rules.

Quit Blackjack

Retums to the main game screen.

Video Poker

When you select video poker, you will see three video poker
machines (color version only). Click on the center machine
to play. You will be asked to choose to play the §1, 35, $25 or
$100 machine.

The name of the current player and their bankroll amount is
shown on the top of the screen. Click on the Change Player
button to select a different player.

Video poker allows you to play 1 to 5 coins. Click on the
desired number of coins. After the coins are pul inlo the
machine, click on the Deal box to deal the cards. Below each
card is a Hold button. Click on this button to toggle the card.
After you have made your choices, click on the Deal button
to re-deal.

Options Menu
Deal
Performs the same function as the Deal bution.
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PayolTs

Shows a table of how much each type of bet pays. Click the
mouse bution to make the payoff table disappear.

Rules

Displays the basic rules for playing video poker. Click the
mouse button when you are done reading the rules.

Quit Video Poker

Retums to the main game screen.

Baccarat

After selecting Baccarat, you will find yourself seated at a
Baccarat table (color version only). You can see what your
tablemates have to say and then click on the middle of the
table to play. You will then be asked to select a table limit (31,
$3, $25, $100).

The names of all the players along with the amount of their
bankroll are displayed on the lower righthand side of the
sCreen.

The four playing positions are represented by numbered
boxes on the screcn.

Placing bets

To place a bet, click on the desired chip amount and hold the
mouse button. Now place the pointer over the table at the bet
location (Tie, Banker, Player) above the box for the desired
position. Release the button and the chip will stay at the
selected spot.

When all bets are placed, click on the Deal button,
Clearing bets
To clear all the bets off the table, click on the Clear button.
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Options Menu

Clear Bets

Performs the same function as the Clear button.
Deal

Performs same function as Deal button.
Payoffs

Shows a table of how much each type of bet pays. Click the
mouse button to make the payoff table disappear.

Rules

Displays the basic rules for playing Baccarat. Click the mouse
button when you are done reading the rules.

Quit Baccarat
Returns to the main game screen.

Slot machine

H

After choosing to play the slot machine, you will see several
guests standing in front of a row of machines {color version
only). Click on the rightmost machine to play.

You will then be asked to select what type of slot machine to
play ($1, §5, $25, $100),

You will be standing in front of a slot machine. The name of
the current player along with their bankroll amount is shown
at the top of the machine. To change the current player, choose
Change Player from the Options menu.

The slot machine will accept from 1 10 3 coins. To put the
coins in, click on the desired button. After the desired coin
button is selected, click on the handle to spin the machine.
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Options Menu

Spin

Performs the same function as the handle on the slot machine.
Change Player

Selects a different player to be the current player.

Show Payolls

If you want the program to display coins representing the
payofl each time you win, select this option. A check mark
indicates the option is selected.

Rules

Displays the basic rules for playing slots. Click the mouse
button when you are done reading the rules.

Quit Slots
Retums to the main game screen.

Miscellaneous

Opening other applications while using Trump Castle Il may
overwrile chips and/or cards left on the table.

There may be some versions of the Macintosh Classic that
will fail if Trump Castle 11 is the first application run after
turning the computer on.
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Additional Information

Backups

Backup copies of Trump Castle 11 are available directly from
IntraCorp. The $12 charge for the set can be paid by check,
money order, American Express, Visa, MasterCard, or COD.
To order, write to IntraCorp, Inc., 7200 Corporate Center
Drive, Suite 500, Miami, FL 33126 or call 1-800-INTRACO
(1-800-468-7226) between 10 a.m. and 6 p.m. Eastern time
(Monday through Friday).

Technical Sugm - Please read cﬁfullg

Credits

Registered owners of this software product are entitled to
technical support from our Customer Service Depart-
ment. If you have any problems or questions, please call
Customer Service at (305) 591-5%40 between 10 a.m. and
5 p.m. Eastern time (Monday through Friday). Please note
that the warranty card that came with this product must
be mailed to IntraCorp before any assistance can be given.
Please allow sufficient time for the card to arrive before
calling Customer Service.

The IntraCorp Customer Support bulletin board is available
to all users. Callers can leave guestions o the Technical
Support deparument or 1o other users, and get information on
software upgrades and new releases. The board is available
lo users 24 hours a day. The board’s number is (303) 471-
8062. It is accessible at 300, 1200 or 2400 baud; no parity; 8

data bits; 1 stop bit

Trump Castle II is sold under license to the user. Please see the licensing
agreemenl included with the package for details of the license.

Macintosh is a trademark of Apple Computers Ine.

Program, manual and packaging design Copyright 19911992 IntraCorp, Inc.
Trump Castle Il User’s Manual by David Turner.
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